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Publishing a Web Site

Now that you’ve created your Web site in a "staging" area (a place where others cannot find or view the pages), your Web site is ready to publish on the World Wide Web or on an intranet. [image: image7.png]Microsoft
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Publishing a Web generally means copying the files that make up a Web site to a particular destination, such as a server. Use the publishing feature in FrontPage 2000 to copy the Web site to your Internet service provider's (ISP) server or to your district or school intranet server. 
Before you begin

· Check the spelling on each Web page in your Web site. For information on checking the spelling, see the Checking the spelling in your Web site section in the Adding Content to a Web Site chapter of this book.

· Using the Reports view, verify that all the hyperlinks are valid. For more information on checking links, see the Managing hyperlinks on your Web site section in the Connecting Pages chapter of this book.

· Using the Tasks view, verify that all tasks have been completed.

· Your Internet or intranet provider should have FrontPage 2000 Server Extensions to support the publishing of your Web site. For information, see http://www.microsoft.com/frontpage/, and click Find an Internet Service Provider that Fully Supports FrontPage. You'll also need to know the ISP's Web server location for publishing your Web, and your user name and password, if necessary. Although it is easier to publish your Web site on a server with FrontPage Server Extensions, you can also publish to a non-FrontPage Server Extension server using FTP.

· Make sure your Web site is ready for publishing by checking for broken hyperlinks, verifying that the pages look the way you want them to, and testing the Web to make sure that everything works. A good way to ensure your Web is ready is by previewing it in a Web browser and navigating through the site, and then by reviewing the status of your files in Reports view.

Understanding server extensions

There are several benefits to publishing to a Web server with FrontPage Server Extensions: 

· Your Web will have full FrontPage 2000 functionality when it is published. Without the server extensions, advanced server-side features will not work, including form handlers, search, hit counters, discussion webs, and component features. 

· FrontPage 2000 maintains your files and hyperlinks—each time you publish the Web, FrontPage2000  compares the files on your local computer to the files on the Web server. For example, if you move a file in your local Web, FrontPage 2000 updates and corrects any hyperlinks to it, and then makes the same corrections to the files on the Web server the next time you publish the Web. 

· After you have published the Web, you will be able to edit it directly on the ISP's Web server (however, the local version of your Web will not remain in sync). 

· If your Web server has FrontPage Server Extensions, FrontPage 2000 can publish your Web using HTTP (HyperText Transfer Protocol). Otherwise, your Web will be published using FTP (File Transfer Protocol).

· Finally, Office 2000 applications can save files directly to your FrontPage-based Web site if the Web server has the FrontPage 2000 Server Extensions installed. 

Understanding Web site publishing

If your ISP has given you a size limit on the Web server, file management is a necessity. You can keep the size of your Web down by deleting old files, especially those with many graphics. Use the Reports view to run a report on Older Files. With this report, you can know which files are old. Once you have published a Web, FrontPage 2000 can synchronize the files on your local Web with the published files on the Web server, each time you publish again.

After you delete files on your computer, FrontPage 2000 prompts you about deleting the same files on the Web server when you publish your Web again, and you can choose to publish only pages that have changed.

If your Web server uses FrontPage Server Extensions, FrontPage 2000 can also match other actions on the Web server, such as moving or renaming files, the next time you publish your Web. FrontPage 2000 updates your navigation bars, shared borders, and hyperlinks on the Web server to match the actions you performed on the Web on your computer.

Choosing a location for your Web site

With FrontPage 2000, you can save your Web in multiple places at once. You can create your Web on a hard disk, network drive, or Web server. Note that only publishing to a Web server makes the Web site available on the World Wide Web. 

You can publish or save your Web to the following locations:

· Your hard disk or a network drive. Type the path or file location. Keep in mind that others who use your computer or are on your network can view, open, and change these files through the file system. Be sure to store your Web site in a subdirectory on your hard drive, not at the root directory (for example, in c:\my Webs\ rather than c:\). That way, if you ever need to delete the Web, you delete a file folder instead of having to select files from the root directory.

· Your Personal Web Server. If the name of your personal computer is "Central High" you can create a Web to http://Central High/School Web. Personal Web Servers allow you to create Webs and test Web functionality on your own computer. Microsoft Personal Web Server ships with Microsoft Windows 95 and Windows 98, or is available for download in the Windows NT Option Pack. 

· Your school intranet server. An intranet is a Web or series of Webs that are available only within a particular networked environment. For example, in a school district, schools may create their own Web pages and then publish these pages to a computer running Web-server software. People on the network can view the pages by typing in a path such as http://DistrictWeb/ (intranet addresses don't contain the "www" prefix).

· A World Wide Web server. The World Wide Web is made up of an enormous network of servers located all over the world, all accessible using a Web browser. Web servers that "host" sites that are viewable on the World Wide Web may exist within your own district or school, or schools contract with a Web hosting provider or Web presence provider to host their site. 

Choosing files to publish

You can choose which files to publish, and which ones not to publish. For instance, if a page is incomplete, you can mark the file so that it doesn’t get published. Later, if you decide to publish the file, you can change its publishing status.

You can also choose to publish only those files that have changed. FrontPage 2000 compares the files in the working Web on your local computer to the published files on the Web server. If FrontPage 2000 detects a newer version of a file on your local computer, the file is published to the Web server.

Marking the pages to publish

You can specify which files you want to publish. FrontPage 2000 automatically marks files for publication, but you can change this setting. For example, if you have not finished editing a page but you want to publish your Web site, you can prevent the page from being published by marking it as “Don't Publish.” When you want to publish the file, mark the page “Publish.” 

To mark a page to exclude from publishing

1. Select the file you want to mark as excluded from publishing and right-click on the file. 

2. Click Properties on the shortcut menu, and then click the Workgroup tab. 

3. To prevent a file from being published, select the Exclude this file when publishing the rest of the web check box. 

To mark a page to include in publication

4. Select the file that you previously marked as excluded from publishing and right-click on the file.

5. To mark a file for publishing, clear the Exclude this file when publishing the rest of the web check box. 

Viewing the publishing status of files

You can view the publishing status of all the files in a Web by running a report. The Publish Status report indicates whether a file has been marked as “Publish” or “Don't Publish.” All files are marked as “Publish” unless you change the status. 

To view the publishing status of files

6. On the View menu, click the Reports button to go to Reports view.

7. On the Reports toolbar, select from Publish Status the drop-down list. 

8. The Publish column displays the publishing status of each file.

Publishing your Web site

With FrontPage 2000, you can use two methods of publishing to your Web hosting service—Front Page Server Extensions or FTP (file transfer protocol). Both work, but if your Web hosting service has FrontPage Server Extensions, you can publish your Web by just entering the Web site’s address as you would when viewing it in your browser. If FrontPage Server Extensions are not installed on the server, you can use FTP (file transfer protocol) to copy the files to the server. 

You also have the following options regarding how to publish the files: 

· Publish only the files that have changed. FrontPage 2000 compares the files on your local Web to the files on the Web server, and only those files that are newer than those on the Web server are published. However, files that have been marked Don't Publish are not published. 

· Publish all files, except those that have been marked Don't Publish. The files from the local Web overwrite all files on the destination Web server, even if the files on the Web server are newer. 

· Publish subwebs if the current Web has subwebs. All files and folders in subwebs are recursively published in addition to those in the current Web. 

· Publish the Web using a secure (SSL) connection. For example, use this feature if your Web server uses the HTTPS protocol to authenticate its users. 

Publishing to HTTP, FTP, or a file system 

Publish using HTTP (HyperText Transfer Protocol) if the FrontPage Server Extensions are installed on the Web server to which you are publishing.

Publish using FTP (File Transfer Protocol) if the FrontPage Server Extensions are not installed on the Web server to which you are publishing. If you have not already added the FTP location, you need to know the FTP server name and directory path. 

You can publish your Web to a folder on your local file system or to a UNC path. For example, you can make a backup copy of your entire Web by publishing it to a new disk-based location, such as C:\Backup. Publishing a Web rather than just copying files ensures that all necessary files are saved and in the correct structure. 

To publish your Web site

9. On the File menu, click Publish Web. The Publish Web dialog box appears.

10. Click Options to expand the list of options. 

11. Specify whether you want to publish only pages that have changed, or all pages. 

12. To publish subwebs, select the Include subwebs check box. All files and folders of the subwebs in the current Web is published recursively, in addition to the files and folders of the current Web. 

13. In the Specify the location to publish your Web to box select the location you want to publish to: 

· HTTP. Type the location of a Web server, click the arrow to select a location to which you have published before, or click Browse to find the publishing location.

· FTP. Type the FTP server location (ftp://ftp.server.com/~folder) in the Publish Web dialog box (be sure to type ftp:// before the server name), and then type your user name and password in the dialog box that appears. To find an FTP site, click Browse, click the FTP site in the Look in box, and then click Open.
· File system. Type the path to the folder on your file system, such as C:\MyWebs or \\Webs\Myfolder. To find the folder, click Browse. 

14. To publish using a secure connection when publishing with HTTP, select the Secure connection required (SSL) check box. Your destination Web server must support SSL for this feature to work. 

15. Click Publish. FrontPage 2000 publishes your Web. If you cancel publishing in the middle of the operation, files that have already been published remain on the destination Web server.

Adding or changing an FTP location

When you publish your Web to an FTP location, you can set up the FTP location, and your user name and password, in advance. Then, whenever you publish your Web, your login information is provided automatically. After adding an FTP location, you can change it, for example to update your password.

Before you can set up an FTP location, you need to know the FTP server name and directory path. The FTP server name is the domain name of the Web server to which you are publishing (for example, ftp.server.com). The directory path is the folder on the server where your Web is stored (for example, /www). If you are unsure about your user name, password, or FTP location, contact your Internet service provider. 

To add, change, or delete an FTP location

16. On the File menu, click Publish Web. 

17. Click Browse. 

18. In the Look in box, click FTP Locations. 

19. Double-click Add/Modify FTP Locations. 

20. To add an FTP location, do the following: 

· In the Name of FTP site box, type the FTP server name and directory path, for example ftp.server.com/www, and click Add.

· Under Log on as, specify whether you want to log on to the FTP server as an anonymous user, or specify your user name and password. Then, click Add.

21. To modify an FTP location, do the following: 

· Under FTP sites, click the site to modify. 

· Under Log on as, change the settings as needed, and then click Modify. If you want to change the FTP site name, you must add the site as a new FTP location. 

22. To remove an FTP location: Under FTP sites, click the site, and then click Remove. 

Deleting a file or folder that has been published

When you publish your Web, FrontPage 2000 compares the current files on your local computer to those files on the Web server. To manage files on the Web server (for example, to get rid of old files or folders), delete or move the files or folders in the Web on your local computer. FrontPage 2000 then prompts you about which files to delete on the Web server the next time you publish.

Extending your knowledge

Publishing your Web is like orchestrating a complicated performance. Although FrontPage 2000 makes Web publishing simple, it takes planning and coordination to make everything work. Web maintenance doesn’t stop once your Web is published. Because information changes, updating your Web periodically is critical.

Updating your Web

At it’s best, a Web should contain current information. To keep your Web up-do-date, you need to upload new information whenever necessary. If you need to make a lot of changes, you use the same procedure to upload the new files that you used when you first published your Web. If you have any questions regarding this procedure, contact your network administrator.

Publishing changed pages

If you are publishing a FrontPage Web that has been published at least once before, use the following method to copy only those pages that have been edited since the last time you published or copied the FrontPage Web.

To copy to the server

23. On the File menu, click Preview in Browser, and click Preview.

24. On the File menu, click Close.

25. Click the Publish FrontPage Web button.

26. In the Publish dialog box, click OK.
- or -  
If you want to change the location, click More Webs.

27. Save your changes and close FrontPage 2000.

Exploring the Microsoft FrontPage Web site

Look over the Microsoft FrontPage home page, and explore some of the links. The site provides product and resource information you can download and is updated frequently with upgrades, educational support and exchanges, technical help, and many other types of useful information.

To go to the Microsoft FrontPage Web site

28. Open your Web browser and type http://www.microsoft.com/frontpage/ in the Address box, and then press ENTER.

29. Follow the link to the MSDN Online Web Workshop and check out the collection of tips and tricks and how-to articles for FrontPage 2000.

30. Select the Office Update link from the FrontPage Web site to find free downloads, updates, and assistance for FrontPage 2000.

31. Click the links to view pages in the Web site.

32. To download information, see your network administrator.

What you will do:





Publish your Web.�


Learn about where to publish your Web.�


Visit the Microsoft FrontPage Web site.�


Update your Web.
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You can right-click the page icon from the Folder List in any view, click Properties on the shortcut menu, and then click the Workgroup tab.
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To publish only pages that have changed to the same location you previously published to, click Publish �.
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If you are publishing to a Web server without FrontPage Server Extensions, you are notified of any features that require the server extensions.
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